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Copyright
Software copyright© 1997-98 by PGSoft Incorporated.

Documentation copyright© 1997-98 by PGSoft Incorporated.
All rights reserved. No part of this book may be reproduced or processed, copied or distributed using 
electronic systems in any form (printing, photocopying or by any other means) without the written con-
sent of PGSoft Incorporated.

Save Butt™ is a trademark of PGSoft Incorporated. PGSoft® is a registered trademark of PGSoft Incor-
porated. 

PGSoft Online
Please visit these PGSoft Web sites for additional product information:

For the latest Save Butt product information, go to the Save Butt Web site at http://www.savebutt.com

For information about desktop utilities available from PGSoft, go to the PGSoft Web site at http://
www.pgsoft.com

Save Butt Software License
IMPORTANT: CAREFULLY READ ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT 
BEFORE INSTALLING THIS SOFTWARE.

By installing Save Butt, you are implicitly accepting the following terms and conditions:

1. LICENSE. PGSoft, Inc. hereby grants you a nonexclusive license to use Save Butt (“Program”) sub-
ject to the terms and restrictions set forth in this License Agreement.

2. COPYRIGHT. This Program and its documentation are protected by U.S. and international copyright 
provisions and may contain confidential information and trade secrets of PGSoft, Inc. You may not copy 
or otherwise reproduce any part of the Program or its documentation, except that you may load the Pro-
gram into the Equipment (as defined below) as an essential step in executing the Program on the Equip-
ment, and as otherwise explicitly stated in this License Agreement.

3. BACK-UP COPIES. You may produce one copy of the Program onto any machine readable form for 
back-up purposes only in support of the use of this Program as specified in this License Agreement. You 
must reproduce and include the copyright notice and trademarks on the back-up copy exactly as they 
are displayed on the original copy.
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4. RESTRICTIONS ON USE AND TRANSFER. The original and back-up copy of the Program and its 
documentation are solely and exclusively for use on a single computer (“Equipment”). You may not use 
the Program in connection with any equipment other than the Equipment. You may not electronically 
transfer the Program from one computer to another over a network or as part of a time-sharing service. 
You may not distribute copies of the Program or documentation to others. You may transfer this license 
together with the original and back-up copy of the Program and its documentation, provided that you 
give prior written notice to PGSoft, Inc. and that the transferee agrees to be bound by the terms of this 
License Agreement. 

Neither the Program nor its documentation may be modified. YOU MAY NOT USE, COPY, MODIFY, 
REVERSE ENGINEER, RENT, OR TRANSFER THE PROGRAM OR DOCUMENTATION OR ANY 
COPY EXCEPT AS EXPRESSLY PROVIDED IN THIS LICENSE AGREEMENT.

5. TITLE. PGSoft, Inc. reserves all right and title to this Program and to the documentation. You have 
purchased only a license to use this copy of the Program and the documentation. PGSOFT, INC. OWNS 
THIS COPY AND ALL BACK-UP COPIES OF THE PROGRAM, AND YOU HAVE ONLY THE LIMITED 
RIGHTS GRANTED BY THIS LICENSE. YOU DO NOT OWN ANY COPIES OF THE PROGRAM OR 
THE DOCUMENTATION.

6. U.S. GOVERNMENT RESTRICTED RIGHTS. The Program includes commercial computer software 
and commercial computer software documentation developed exclusively at private expense by PGSoft, 
Inc., 510 Lighthouse Avenue, Pacific Grove, California 93950. U.S. Government rights to use, modify, 
reproduce, release, perform, display, or disclose this computer software and computer software docu-
mentation are subject to the limited rights restrictions of DFARS 252.227-7015(b)(2) (June 1995) and/or 
subject to the restrictions of DFARS 227.7202-1(a) (June 1995) and DFARS 227.7202-3(a) (June 1995), 
as applicable for U.S. Department of Defense procurements and the limited rights restrictions of FAR 
52.227-14 (June 1987) and/or subject to the restricted rights provisions of FAR 52.227-14 (June 1987) 
and FAR 52.227-19 (June 1987), as applicable, and any applicable agency FAR Supplements, for non-
Department of Defense Federal procurements.

7(a). DISCLAIMER OF WARRANTY ON PROGRAM. If PGSoft’s Save Butt doesn’t work, tough. If you 
lose millions because Save Butt messes up, it’s you that’s out the millions, not us. If you don’t like this 
disclaimer, tough. We reserve the right to do the absolute minimum provided by law, up to and including 
nothing. This is basically the same disclaimer that comes with all software packages, but ours is in plain 
English and theirs is in legalese. We didn’t really want to include any disclaimer at all, but our lawyers 
insisted. Ok, we were just seeing if you were reading this license agreement. The real paragraph is 
below.

7(b). DISCLAIMER OF WARRANTY ON PROGRAM. The Program is provided “AS IS” WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE PROGRAM IS ASSUMED 
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BY YOU. PGSOFT, INC. DOES NOT WARRANT THE PERFORMANCE OR RESULTS THAT MAY BE 
OBTAINED BY USE OF THIS PROGRAM. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU 
(AND NOT PGSOFT, INC.) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, 
REPAIR, AND CORRECTION.

8. LIMITATION OF LIABILITY. NEITHER PGSOFT, INC. NOR ANYONE ELSE WHO HAS BEEN 
INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY OF THIS PROGRAM SHALL BE LIA-
BLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT 
OF THE USE, RESULTS OF USE, OR INABILITY TO USE THIS PROGRAM, HOWEVER CAUSED, 
UNDER ANY THEORY OF LIABILITY EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES 
OR CLAIM.

9. TERM. This license is effective until terminated. You may terminate it by destroying the Program and 
documentation and all copies thereof. This license will also terminate if you fail to comply with any term 
or condition of this License Agreement. You agree upon such termination to destroy all copies of the 
Program and documentation.

10.   ACKNOWLEDGEMENT. YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREE-
MENT, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU 
ALSO AGREE THAT THIS LICENSE AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATE-
MENT OF THE AGREEMENT BETWEEN YOU AND PGSOFT, INC. AND SUPERSEDES ALL PRO-
POSALS OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
RELATING TO THE SUBJECT MATTER OF THIS LICENSE AGREEMENT.

11.   GENERAL.   This License Agreement will be governed by the laws of the State of California. If any 
provision of this License Agreement is held unenforceable, the remainder of this License Agreement 
shall continue in full force and effect.
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Welcome to Save Butt

This section welcomes new users, tells you what you’ll find in this book, lists 
your Save Butt package contents, and describes the recommended minimum 
system requirements for installing and using Save Butt software.

What does Save Butt do?
Have you ever accidentally pressed the Save button instead of the Save As 
button? Or forgotten to make a copy of an important document after you’ve 
finished the final edit? Or deleted a file when you didn’t really mean to? Save 
Butt™ protects your most important assets – your documents –by 
automatically copying every file you change or delete and saving the copies to 
your hard disk, removable drive, and/or network server. Should something 
unfortunate happen to your documents, Save Butt can recover them instantly. 
If you make a mistake, all you need to do is press a button to recover any 
previous version of your file. Sound easy? This short book will show you how 
easy it is to install and start using your Save Butt software from PGSoft®.

How does Save Butt work?
As part of the installation process, Save Butt scans your Windows Start menu 
and identifies the applications that are installed on your computer and their 
associated file types. You don’t even have to think about saving copies of the 
files you’re changing. As soon as Save Butt is successfully installed, it will 
automatically track and store all of the documents with which you work.

Save Butt runs in the background, automatically tracks your file changes, and 
copies changed and deleted versions of your files to the location(s) that you 
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specify – your hard disk, a removable drive, and/or a network server. You can 
recover any file you’ve changed or deleted by right-clicking the file in Windows 
Explorer, or by using the Save Butt File Locator to restore your files.

Do I need to read this Getting Started book?
This book is written for both beginners and experienced users. Where it’s 
appropriate, helpful information is provided for performing Windows-based 
tasks that may be less familiar to some users.

This book provides:

• Instructions for installing and starting your Save Butt software

• A quick introduction to the Save Butt basics and features 

Preliminary checklists
There are a few preliminaries to cover before you’re ready to install Save Butt. 
It’s a good idea to check your package contents and the minimum system 
requirements for running the software.

Check your package contents
Check that your Save Butt software package contains these items: 

• Registration card

• Save Butt User�s Manual 

• PGSoft Save Butt CD-ROM
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Check the minimum system requirements
Check that you have the following minimum system requirements:

• IBM PC or PC-compatible with a 486 processor or higher

• 8MB of random access memory (RAM)

• Hard disk with 15 Megabytes of free space

• Microsoft Windows 95 or Windows 98 operating system software
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Installing Your Save Butt Software

Now that the preliminaries are out of the way, you’re ready to install the Save 
Butt software on your computer. 

1 Exit all applications you have open and put the PGSoft Save Butt 
CD-ROM into your CD-ROM drive.

2 When the Save Butt Setup program starts, follow the prompts and 
instructions that appear on your screen.

The Setup program will guide you through the installation process. Be 
sure to provide the information that the program requests. 

If the Save Butt Setup program does not automatically start, follow these 
steps.

1 From your Windows Start menu, choose Run to open the Run dialog box.

If you’re new to Windows, click the Start button to open the Start menu, 
and then click Run.

2 In the Run dialog box, type the following. In place of Drive letter, type your 
CD-ROM drive letter.

Drive letter :\setup

For example, if the drive letter of your CD-ROM drive is D:, you will type: 
D:\setup
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3 Click OK, and when the Save Butt Setup program starts, follow the 
prompts and instructions that appear on your screen.

4 Peel off the Save Butt key on the front of your package and apply to the 
F12 key. Anytime you need to launch Save Butt, simply click the Save Butt 
key.

Registering your Save Butt software
Please register your Save Butt software. As a registered user, you will receive 
free technical support and information on new product developments and 
upgrades as soon as they become available. 

During installation, you will be asked if you want to register online. You can 
register online if you have access to the Internet, and if a Web browser such 
as Netscape Navigator or Microsoft Internet Explorer is installed on your 
computer.

If you don’t register online, please fill out and return the registration card you 
received in your Save Butt package.
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A Quick Introduction to Save Butt

When you have successfully installed Save Butt on your computer, you can 
open the Save Butt application window and learn your way around. 

This section provides the information you need to start using Save Butt and 
become familiar with its features and components. The following topics are 
covered:

• Starting Save Butt 

• Identifying the features and components in the Save Butt application 
window 

• Using Save Butt menus 

• Visiting PGSoft Web sites and using Web services

• Restoring files 

• Deciding where to store copies of revised and deleted files and setting 
drive preferences 

• Stopping and restarting the revision and deletion tracking

• Using advanced features 
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Starting Save Butt
You can start Save Butt in any of the following ways.

• Press the Save Butt key (F12) key. 

• Double-click the Save Butt program icon, which is located on the 

Windows taskbar (next to the time display) and looks like this. 

• Open your Windows Start menu and then choose PGSoft Save Butt from 
the Programs menu.

Working with the Save Butt window
Starting Save Butt for the first time opens the basic Save Butt window. 

Close button

Menu bar

File Locator

Status bar
Save Butt User’s Manual 7



Using Save Butt menus
The Save Butt menu bar contains three menus. You can use the standard 
Windows keyboard shortcuts to open menus and choose commands. For 
example, press ALT+F to open the File menu; then use the up and down 
arrow keys to select commands.

File menu

View menu 

Choose Close to close the Save Butt window.

Choose Exit to quit the Save Butt program and stop 
tracking revisions and deletions. 

Choose Advanced User to see more features than 
are available in the basic Save Butt window. Choose 
Advanced User again to return to the basic window. 
You’ll learn about advanced features on page 24.

Choose Refresh to refresh the Save Butt File Locator 
display.

If your computer does not automatically restart after 
you install a new program, choose ReScan to update 
the list of applications and file types that Save Butt 
tracks.
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Help menu

Choose Contents to get online Help while you’re 
working in the Save Butt window. 

You can also get helpful information from messages 
that appear in the status bar at the bottom of the Save 
Butt window.

Choose PGSoft on the Web to access online 
services that are available if you have an Internet 
connection and a Web browser installed on your 
computer. To learn more about these services, see 
the “Using PGSoft online services” topic next.

Choose About Save Butt for program information.
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Using PGSoft online services
Click the Online tab in the Save Butt window to visit the PGSoft and Save Butt 
Web sites. 

If you didn’t register online 
when you installed Save Butt, 
click here to register.

Click here to check for 
software updates and update 
your Save Butt software over 
the Internet.
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Restoring files
Click the Save Butt tab in the Save Butt window to display the Save Butt File 
Locator. You use the File Locator to choose options for restoring changed and 
deleted files and to view your revision lists.

During the installation process, Save Butt selected your hard disk drive as the 
default target drive – the drive where Save Butt will store copies of your file 
revisions and deleted files. The target drive’s drive letter is the one you see in 
the Drive drop-down list box on the right side of the window. 

Restore button

Drive selection drop-down list 
box

File Locator drop-down list box

File Locator
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The File Locator drop-down list box (beneath the Restore button) lists the 
many options available for restoring files. If you’re new to Windows, click the 

arrow next to a list box  to view the list of items. In the example on page 11, 
the user has chosen to see a list of all files that have been changed or deleted 
recently.

The Save Butt File Locator shows the following information.

A plus sign next to a file name indicates that more than one version of the file 
exists. To expand the file’s revision list, click the plus sign. A minus sign 
appears next to an expanded list. To collapse the list, click the minus sign.

Save Butt can help you find a file based on what you remember about it, even 
if you can’t remember the file’s name. For example, you can find a file you 
remember changing last month, or a file you know you created using a 
specific application.

Name Modified In Folder Application

File 
name

When the file was 
last changed

Where the file 
is located

Which application 
was used to change 
the file
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To restore a file:

1 From the Drive drop-down list box, select the drive letter on which to view 
revisions.

2 From the File Locator drop-down list on the left, choose which type of file 
list to view.

In the example illustrated on page 11, the user has chosen to see a list of 
all files that have been changed or deleted recently.

3 Select the file’s name in the File Locator list.

Notice that when you select a file, its name appears in the box to the right 
of the Restore button and that information about the file appears below 
the box.

4 Click the Restore button.

5 When prompted to confirm the restoration, click Yes.

If you want to open the file, go to the location indicated in the column labeled 
In Folder -- for example, C:\Windows\Desktop.
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You can also restore an earlier version of a file from Windows Explorer.

1 From your Windows Start menu, choose Programs and then choose 
Windows Explorer.

If you have an Explorer shortcut on your desktop, just double-click the 
Explorer icon.

2 Locate the file that you would like an earlier version of and right-click the 
file name.

3 From the menu that appears (if previous versions of the file exist), choose 
Restore, and then click the file version you want to restore.

Right-click to display the 
menu, then choose the file 
version you want. 
14 Save Butt User’s Manual



Choosing drive settings
Click the Drive Settings tab in the Save Butt window to display options for 
setting up file revision and deletion tracking on your target drives. 

Use these settings to control where and how Save Butt stores the versions of 
changed and deleted files it saves. You can add and remove drives where 
revisions are stored. You can also discard revisions that you no longer care 
about. 

The Target Drives list 
shows all drives that are 
storing revisions and 
deletions.

Click a drive icon or name 
to select the drive. 

Select the default restore 
drive by clicking the check 
box in front of it. This is the 
drive from which Save Butt 
restores files. 
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Setting preferences for all target drives
You can set global preferences – settings that apply to all of the drives in your 
target drives list. 

Adding target drives
Target drives are the drives where you want Save Butt to store copies of 
revised and deleted files. For example, you can be working on a file that is 
located on your floppy drive and Save Butt will automatically copy any 
versions to your target drive(s). You can add any drive that is mapped on your 
computer to your target drives list. (A mapped drive has an assigned letter or 
a name that identifies the drive to the operating system or the network server.) 
To map a network drive, you can right-click My Computer on your Windows 
desktop, and then choose Map Network Drive. See Windows Help for details. 

Important: Save Butt creates a folder named Sb on each of your target 
drives, and stores copies of your changed and deleted files in this folder. It is 
important to avoid manually editing or deleting any of the files in the Sb folder.

Select this check box if you want all target 
drive to have file deletion tracking. 

Select this check box if you want to be asked 
to confirm all file restorations
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To add a target drive: 

1 Click the Add Drive button to open the Add Drives dialog box.

2 From the list of available drives, click to select the drive letter or name of 
the drive you want to add, and then click the Add button.

Click to select a drive, and then 
click Add. 
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Changing the default restore drive
You can use only one target drive at a time as the default restore drive – the 
drive from which you’ll restore files. During installation, Save Butt selects your 
hard drive as the default restore drive. You can change the default restore 
drive by selecting another drive’s check box.

You can override the default when you restore a file (see “Restoring files” on 
page 11). 

Removing target drives
If you no longer want to save revisions and deletions on a drive, you can 
remove the drive from your target drives list. To remove a target drive:

1 Click to select the drive letter or name and click the Remove Drive button. 

2 When prompted to confirm the removal, click Yes. Depending on the type 
of drive, you may see additional prompts to help you remove the drive 
correctly.

Note: Removing a target drive removes all of the revisions and deletions that 
were stored on the drive.
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Discarding revisions
You can discard revisions or deletions that Save Butt has stored on a target 
drive. You might want to do this to free up disk space.

1 Click to select the drive letter or name in the target drives list.

2 Click the Discard Revisions button to open the Discard Revisions dialog 
box.

3 If you want to discard all revisions, click the OK or Apply button.

4 If you want to discard specific revisions, select the options you want in the 
drop-down list boxes. 

For example, you could choose to discard all of your deleted files. Or you 
could discard all Microsoft Word .DOC revisions and deletions.

5 Click OK to apply your changes and close the dialog box.
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Setting preferences for a specific target drive
In addition to global drive preferences, you can also set individual preferences 
for each target drive. 

1 Select the drive letter or name in the target drives list.

2 Click the Drive Prefs button to open the Preferences dialog box.

3 Select the options you want in the drop-down list boxes. You may see 
different options listed, depending on the type of drive you’ve selected. 

4 Click OK. 

Enter the maximum disk space to allow for 
storing revised and deleted files. 

Save Butt asks you to discard revisions if 
available disk space drops below the minimum 
that you enter. 

Select the maximum number of revisions to 
store and how often to store copies of your files. 
When you exceed the maximum number of 
revisions, Save Butt discards the oldest revision 
before saving a new one. 

Select the maximum and minimum file size that 
can be stored.
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Stopping and restarting the Save Butt revision and 
deletion tracking
Occasionally you may want to temporarily stop Save Butt from saving and 
storing versions of your files. It’s easy to stop and restart the tracking 
operation.

To stop revision and deletion tracking:

To temporarily stop Save Butt from saving and storing copies of your changed 
and deleted files:

1 Right-click the Save Butt program icon on the Windows taskbar.  

2 From the menu that appears, select Pause Save Butt.

Pause temporarily stops revision and deletion tracking, but does not exit 
the Save Butt program.

To restart revision and deletion tracking:

1 Right-click the Save Butt program icon on the Windows taskbar.

2 From the menu that appears, select Continue Save Butt.
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Using advanced features
There are features in addition to those provided in the basic Save Butt 
window. From the View menu, choose Advanced User to access the 
advanced-mode features on the Include, Exclude, and Logging tabs. 

Excluding programs and file types from automatic revision and 
deletion tracking
By default, Save Butt automatically tracks all of the applications (and their 
associated file types) that it found in your Windows Start menu when you 
installed Save Butt. Each time you restart your computer Save Butt will scan 
your Start menu for new applications and file types that it should track.

There are three additional tabs 
for advanced features. 
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Click the Include tab to see the list of all applications and file types that Save 
Butt is tracking. You can streamline the way Save Butt works by excluding 
from this list those applications and associated file types that you don’t want 
Save Butt to track. 

To exclude an application, clear the check box next to the application’s name 
in the Applications list.

To exclude one or more of an application’s file types, clear the corresponding 
check box(es) in the File Types list.

Select the name of an 
application in the list to see its 
associated file types. 

If you don’t want Save Butt to 
save revisions and deletions 
for an application or file type, 
clear its check box. 

Application names

Associated file types
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If you decide later that you do want Save Butt to track revisions and deletions 
for an application or file type you excluded, just select the appropriate check 
box to reinstate tracking.

Excluding folders from revision and deletion tracking
By default Save Butt recognizes certain folders on a disk drive that it doesn’t 
need to track. Because Save Butt tracks revisions and deletions regardless of 
where files are stored on your system, certain folders need to be excluded. 
For example, it is not useful to track revisions and deletions of files that are 
stored in a temporary folder. Click the Exclusion tab to see the exclusion list. 
You can modify the list by adding and removing folders.

Select a folder path, or enter a 
path name in the text box. 

If you enter a text string (such 
as Temp), the Save Butt 
software excludes any folders 
that have that string anywhere 
within their path name.

Click to Add the specified 
folder to the list.

Click to Remove the specified 
folder from the list.
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Viewing log files
Click the Logging tab to view a log of all file revisions and deletions that Save 
Butt has tracked. You might want to view the log for more detailed technical 
information on the file operations that Save Butt is tracking.
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Learning more

For more detailed information on how to use Save Butt features and functions, 
use the Save Butt online Help. To display online Help:

1 Select Contents from the Help menu. 

2 In the Contents window that appears, double-click any book to display the 
topics within it. 

3 Double-click a topic title to display that topic. 
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Removing the Save Butt software

We hope that you’ll never want to stop protecting your files; but if you do 
decide to stop using Save Butt, this section explains how to remove the 
software.

If for some reason you want to remove the Save Butt application from your 
Windows Programs menu, you can do so easily.

1 From your Windows Start menu, choose Settings, and then choose 
Control Panel.

2 Double-click the Add/Remove Programs icon.

3 In the Add/Remove Programs Properties dialog box that appears, locate 
and double-click PGSoft Save Butt.

4 If you’re sure that you want to permanently remove the Save Butt 
program, click Yes in the dialog box.

5 When asked if you want to discard stored revisions, click Yes to discard or 
No to retain these files. 
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